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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the 
safe and accurate exchange of information, enabling the collaborative evolution of high 
value business documents. 

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook

 Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending 
emails.

What’s New in Workshare Professional 10

Workshare Professional 10 is a 32-bit and 64-bit release that extends the comparison 
functionality to Excel and improves the integration in Outlook.

Excel comparison

Compare any two spreadsheets and see exactly what’s changed. See the differences 
between individual sheets or your entire workbook.

You can launch Workshare Compare for Excel and perform comparisons from your 
desktop, from right-click options or from an email. Spreadsheets stored in your DMS or 
CRM, locally or on your network can be compared.
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Simpler access to comparison from Outlook

New buttons and dropdown options right where you want them.

Workshare ribbon in Outlook Right-click attachment

Compare two email attachments or even a snippet of text from the body of your email.

Improved PDF comparison

Behind the scenes, it’s better, faster and stronger so comparison of PDF files is more 
accurate and reliable.

Environments changes

 Added support for Microsoft Office 2019

 Added support for Microsoft Office 365 (desktop)

 Added support for eDOCS DM 16.3

 Dropped support for Microsoft Office 2010



Workshare Professional 10 Release Notes

6

Workshare Configuration Manager

The following parameter was added:

 Delete custom XML parts (Word) (Protection > Interactive Protect and Protection 
> Remove Metadata)

The following parameters were removed because the automatic change notification (ACN) 
feature has been removed:

 Attachment(s) Alert & Compare category name (Comparison > Administration)

 Enable Attachment(s) Alert & Compare (Comparison > Administration)

System Requirements

The recommended system requirements for Workshare Professional 10 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare 10 has a 32-bit version for 32-bit Microsoft Office environments and a 64-bit 
version for 64-bit Office environments.

Certified Environments for Workshare 10 (32-bit version)

Workshare 10 (32-bit version) has been tested and certified in a number of environments. 
If your environment is not included in the following list, it may still be a compatible 
environment. Contact Workshare Customer Support (support@workshare.com) for any 
help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

mailto:support@workshare.com
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Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (32 bit)

 Microsoft Office 2019 (32 bit) – including click-to-run

 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop) (32 bit)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use an iManage Work 10 server, it must be installed on-premise or in 
an iManage private cloud. If it’s a Work 10.2 server, it must include iManage Work 
Web Server 10.2.0.91 (which can be requested from iManage with reference 
CSAR-2673).

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare 10 (64-bit version)

Workshare 10 (64-bit version) has been tested and certified in a number of environments. 
If your environment is not included in the following list, it may still be a compatible 
environment. Contact Workshare Customer Support (support@workshare.com) for any 
help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
mailto:support@workshare.com
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Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use an iManage Work 10 server, it must be installed on-premise or in 
an iManage private cloud. If it’s a Work 10.2 server, it must include iManage Work 
Web Server 10.2.0.91.

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert 
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Professional does not support Outlook when it is configured with 
a POP or IMAP account.

Important installation information

 Workshare Professional installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
https://www.microsoft.com/en-us/download/details.aspx?id=25
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 Windows 7: When UAC is set to Default, running the Workshare Professional 
install displays the UAC prompt. You must approve the prompt and Workshare 
Professional will be installed. Running the Workshare Professional MSI silently will 
fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly 
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

CR# Ref Description

01161286 PRO-2146 Apply Accepted Changes Button fails to load changes 
document in Microsoft Word

PRO-2087 "This setup requires <32/64> bit Microsoft Office 2013 
SP1 or later" warning message is not displayed when 
installing (x86) MSI builds in (x64) Office environment and 
vice versa.

CR01160584 PRO-2007 iManage integration: Unable to start a comparison from 
the browser to Compare desktop

CR01160265 PRO-1922 Unable to view exported Excel comparison file

PRO-1921 Compare for Excel binaries were not signed

CR01159811 PRO-1910 Compare for Excel shortcut not created in Start menu

PRO-1897 When searching for “Interwoven” text in Help page, 
Interwoven Integration topic was shown in results

PRO-1893 Help links are not navigating to respective Workshare 
Help pages

CR01159377 PRO-1874 Floating ‘Change Summary’ panel is black when 
comparing specific documents

PRO-1864 Page numbers in footer are not shown in redline 
document

PRO-1840 "This setup requires <32/64> bit Microsoft Office 2013 
SP1 or later" warning message is not displayed when 
installing Compare for PowerPoint or Compare for Excel 
MSIs.
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CR# Ref Description

PRO-1748 Compare for Excel: Warning message is not displayed 
when the user browses/drags and drops a file in one input 
field and copy/paste the path of the same file in the other 
input field

PRO-1697 Error 'Interactive Protect could not be started' is displayed 
while creating a new email when upgrade performed from 
Compare standalone to Professional

01153132 PRO-1617 Error message: "An error has occurred when attempting 
to save the Redline document" when saving the redline 
generated from Selective Compare

01151734 PRO-1568 Interactive Protect panel hangs with 'Discovering' 
message when adding attachments using Outlook 365

01150846 PRO-1564 Attachments are still cleaned after unchecking 'Select 
metadata to remove' options on Interactive Protect panel

01149167 PRO-1563 Data in checkboxes removed when document is cleaned 
with Lightspeed Clean

01148594 PRO-1518 Saving a comparison as a Word document with track 
changes can take a long time to process when specific 
documents have been compared

PRO-1515 'iManage Work10 login' dialog is shown when user clicks 
on 'Create PDF' button when performing 'Combine files in 
Workshare' action on legacy server document after 
clicking on 'Add Files' button

01148122 PRO-1511 When comparing specific documents, the list numbering 
font is changed to Calibri

01148530 PRO-1485 Error message 'We can't complete this because we can't 
contact the server right now. Please try again later' 
displayed when sending emails

01145280 PRO-1406 Comparison failed when documents containing comments 
and 'Display comments in redline' rendering option is 
enabled

PRO-1390 'There was a problem with the installation: The application 
requires .NET 4.6.2 framework installer' error message is 
displayed when trying to install Professional build.

01143410 PRO-1350 Warning message "Workshare 9 was unable to retrieve 
the original/Modified source document." when comparing 
PDF documents from an email

01141386 PRO-1306 Documents with Unicode characters displayed in redline 
incorrectly and when saving as PDF
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CR# Ref Description

01141196 PRO-1299 Comparing PowerPoint documents shows distorted or 
enlarged images/logos as a background

01139131 PRO-1174 Redline shows incorrect changes in paragraph indentation 
and alignment

01134033 PRO-1009 A ‘content discovery failed’ error is displayed when 
cleaning Excel sheets containing Russian Cyrillic 
characters

PRO-987 A repair of Professional is forced when one of the default 
rendering sets are deleted using the Workshare 
Configuration Manager

01073292 PRO-891 Request to change the name from “InterwovenSite” to 
“iManage” in Compare document selection screen

01086760 PRO-883 Unable to apply changes when saving specific 
comparison as Track Change document

01084380 PRO-875 Unable to apply changes when saving specific 
comparison as Track Change document

01069051 PRO-871 Unable to open or save a specific redline in Word with 
Track Changes

01087177 PRO-852 Unable to apply changes when saving or opening specific 
comparison as track change document

01074067 PRO-851 Stamp signatures in PDF documents are removed when 
deleting markups using Batch Clean

01097073 PRO-811 Open in Word with Track Changes option causes 
Microsoft error

01097277 PRO-810 Comparing tables with list numbering adds extra 
numbering to the list using Fast mode

01126464 PRO-700 A copy of a discarded 'forward' or 'reply' draft email is 
added to the 'Deleted Folder' in Outlook

01117316 PRO-558 Comparing certain documents in Standard mode causing 
Compare to crash

01116873 PRO-555 Compare does not come to focus when starting 
comparison from Opentext Explorer

PRO-255 Unable to use Content Risk on a password-protected 
document in Read Only mode without entering the 
password

01105573 PRO-236 Footer not shown when setting 'Header position from top' 
to 0
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CR# Ref Description

01104565 PRO-225 Protect is converting the contents of specific PDF/A files 
to white text

01056554 PRO-211 Error: ''Microsoft Word - We're sorry. We can't open 
V1.doc-V2.docx because we found a problem with its 
contents'' when opening/saving redline in Word with track 
changes

PRO-99
The Link option is displayed in the attachments bar even 
after deleting all attachments from an email written in plain 
text format

45581

When sending an email to a distribution list and applying 
the Secure File Transfer or Clean & Secure File Transfer 
policy (Protect Profile dialog), the email is processed and 
sent without showing the information dialog about the 
recipients within the distribution list

45745
ACN is not triggered when Outlook is configured in online 
mode

Known Issues

The following are known issues in the Workshare Professional 10 release - for more 
information, please contact Customer Support.

Ref Description

PRO-2302

Compare for Excel: When selecting files to compare from a DMS and 
manually changing the version number in the document path (in the
Original or Modified fields), ‘The file cannot be found’ error message is 
displayed.

PRO-2085
Compare for Excel and OpenText: When selecting a version for 
comparison, the version number is not displayed in the Original or 
Modified fields.

PRO-1774

Compare for Excel: When dragging an unsupported file type into the 
Original field, an error message is displayed below the field. If another 
unsupported file type is then dragged into the Modified field, an error 
message is displayed below the Modified field. However, the error below 
the Original field disappears even though the file in the Original field is 
still unsupported.

01157234
PRO-1763

iManage Work 10: When saving a comparison to iManage from Workshare 
Compare, the security for the document is set to Private by default.
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Ref Description

PRO-1749
Compare for Excel and NetDocuments: Recently compared spreadsheets
are not displayed in the input fields drop down after comparing 
NetDocuments spreadsheets.

PRO-1695

Compare for Excel and NetDocuments: When comparing spreadsheets 
from NetDocuments, the date and time shown in the Original and 
Modified fields in the selection dialog does not match the date and time 
shown for the files in NetDocuments.

PRO-1624
Compare for Excel: The keyboard tab key may not work consistently when 
using it to move through actions in the selection dialog.

PRO-1597
Compare for Excel: When using keyboard keys to select spreadsheets for 
comparison in the selection dialog, removing a selection may not work as 
expected.

PRO-1504
Compare for Excel: The empty cell is not highlighted as inserted/deleted 
along with the rest of the changed row/column on comparing documents 
having empty column and with inserted/deleted rows.

PRO-1387
Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row 
is empty.

PRO-1386
Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019
Compare for Excel: Focus is not completely applied to the last change in 
the comparison window if the user clicks the Last Change button for the
first time.

01061816
PRO-837

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned.

01088791
PRO-792

After running a comparison in Workshare Compare, some line numbering
and table text and row cells maybe be missing.

PRO-690
01125849

When sending documents for comparison from NetDocuments, the 
following error is displayed even though the documents are compared 
successfully: “80040154 Class not registered (Exception from HRESULT: 
0x80040154(REGDB_E_CLASSNOTREG))”.

PRO-528
IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when 
the email is processed through desktop profiles or all mail profiles. This is 
an issue with IBM Notes.

PRO-527
IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

PRO-525
The positioning of signature components in RTF format emails can be 
incorrect after processing with Protect.

http://www-10.lotus.com/ldd/fixlist.nsf/8ed1b46cfdba8957852570c90054623b/dbf1eb80caf496f0852580d800738d12?OpenDocument
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Ref Description

PRO-109
01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01018743
The font in the email body changes to Times New Roman when sending 
attachments to groups in Interactive Protect.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds 
of the array' error is displayed.

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574
A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the 
incorrect comparison theme is highlighted under the Select dropdown in 
the Home ribbon.

45583
When a machine is restarted before the convert to link process has 
completed, files which are not synced are moved to a conflict state in the 
desktop app.
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Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090

Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy 
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help 
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective 
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
http://www.workshare.com/
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